
 

1  

XL1001 – Advance Data Management and 
Analysis using Excel 

 

Table of Contents 

Module 1 – Using Names 

 What is Name? 

 The advantages of using Names 

 Name for single cell 

 Name for literal value 

 Name for expression 

 Name for multi-cells range 

 Name Scoping, ambiguity and conflict resolution 

 Modify Name 

 Delete Name 

 

Module 2 – Using Table Features 

 Creating a Table 

 Delete Table 

 Change Table Name 

 Sorting a Table 

 Filtering a Table 

 Working with the Total Row 
 Creating a Calculated Column 

 Formatting a Table 

 Referring to different parts of table 

 

Module 3 – Working with Formatting  

 Applying Conditional Formatting 

 Formatting based on Cell values 
 Formatting based on Formulas 

 Other Conditional Formatting (bars, scales, icons) 
 

Module 4 – Working with Data Validation 

 Using Data Validation 

 Entry guide 

 Custom Error Message 

 Creating and Using Custom Formats 

 Using the Quick Analysis Tool 

 Using Table for Validation 

 Exception cases where data validation will fail 

  



 

2  

Module 5 – Prevent invalid entry with Controls 

 What is Controls 

 Problems with text entry. 

 Handle Yes/No value with Check-Box 
 Select one out of many with Radio-Button 

 Use Combo-Box and List-Box 

 Increase and decrease value with Spin Button 

 Techniques to hide cell values 

 Techniques to prevent user direct data entry  

 Different between Form and ActiveX Controls 

 

Module 6 – Important Functions 

 TEXT Functions 

 IF 

 ERROR Functions 

 LOGICAL Functions 

 VLOOKUP and HLOOKUP functions 

 COUNT related Functions 

 SUM related functions 

 SUMPRODUCT 

 DATE & TIME functions 

 FORMULA TEXT (2013) 

 Information Functions (ISNA, ISEVEN, ISERR…) 
 

Module 7 – Data Filtering and Grouping 

 Auto Filter – Filter By Color, Filter by Icon Sets 

 Advanced Filter 

 Remove Duplicates 

 Built-In Subtotal 

 Data Grouping 

 

Module 8 – Data Consolidation 

 Consolidate According to the Position in an Excel Worksheet 

 Identify Categories to Consolidate Excel Data 

 Use Formulas to Consolidate Excel Data 
 

Module 9 – Using PivotTable 

 Create a PivotTable 

 View fields and data 

 Change field settings 

 Styles 

 Filter a field 
 Creating PivotChart Reports 

 Calculated Fields 

 Calculated Items 

 Grouping 

 Formatting – Number/Conditional 

 Slicer 



 

3  

Module 10 – What-If Analysis 

 Goal Seek 

 Scenario Manager 

 Data Tables 
 Solver (Add-In) 

 

Module 11 – Data Visualization 

 Creating Charts 

 Changing the Chart Location and Size 

 Changing the Chart Type 

 Modifying Chart Elements 

 Formatting Chart Elements 

 Adding and Removing Data Series 

 Printing Charts 
 Creating and Using a Chart Template 

 Sparkline 

  



 

4  

Module 1 – Using Names 

 

What is Name? 

In Excel, you can create names that refer to 

a single cell, a group of cells on the 

worksheet, a specific value, or a formula. 

After you define Excel names, you can use 

the names in a formula, instead of using a 

constant value or cell references. 

 

 

An Excel name can't contain space 

characters, and there are other rules to 

follow when you're creating a name. 

 

The first character of a name must be a 

 letter 

 underscore (_) 
 backslash (\). 

 

Subsequence characters in the name can be 

 letters 

 numbers 

 periods 

 underscore characters 
 

Spaces are not allowed as part of a name. 

 

Names can contain uppercase and lowercase letters. But Excel does not 

distinguish between them. For example, North and NORTH are treated as 

the same name. 

 

Names cannot be the same as a cell reference, such as A2, A$35 or R2D2. 

 

You cannot use C,c,R or r as a defined name -- they are used as selection 

shortcuts. 

 

  

N
am

e

Single Cell

Literal/Fixed Value

Expression/Formula

Multi-cells range
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To create names: 

 

 
 

 

 

 

The advantages of using Names 

There are few advantages when using names: 

1. Can make the formulas easier to understand 

2. Address independent. Make workbook maintenance easier 

3. Single point of reference. Any future changes impact will be 

minimized. 

4. The name will be utilized by other aspects of excel and will make 

those aspects better, for instance better scenarios summary and 

clearer solver constraints. 

 

  

Name Box 
Name Manager 
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Name for single cell 

EX1.1: Housing Loan 

 

In this exercise you will learn how to use name to represent single cell. 

1. Insert a new worksheet 

2. Change the worksheet name to Housing Loan. 

 

3. Prepare the worksheet as below: 

 
4. Copy worksheet Housing Loan, and rename the copy as Housing 

Loan (Use Name). 

 

5. Switch to worksheet Housing Loan (Use Name). 

6. Select the Formulas Tab and then click Name Manager button. 
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7. You should able to see the following dialog box, click the New… 

button 

 

8. Create the following names for the active worksheet. 

Name Scope Reference 

HousePrice Housing Loan (Use Name) D2 

LoanPercentage Housing Loan (Use Name) D3 

LoanAmount Housing Loan (Use Name) D4 

DownPayment Housing Loan (Use Name) D5 

AnnualRate Housing Loan (Use Name) D6 

DurationInYears Housing Loan (Use Name) D7 

MonthlyInstallment Housing Loan (Use Name) D8 

MinNetIncome Housing Loan (Use Name) D9 

TotalPayment Housing Loan (Use Name) D10 

FinancialCost Housing Loan (Use Name) D11 

 

9. Change the cells value to the following: 
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Name for literal value and expression 

EX1.2: Payroll 

 

In this exercise you will learn how to use name to represent literal value 

and expression.  

 

Assuming you contribute 11% of your salary to EPF account, and your 

employer contributes 1% more. 

 

1. Insert a new worksheet 

2. Change the worksheet name to Payroll. 

3. Declare a local name called BasicSalary refers to cell D2 

4. The worksheet will be as below: 

 
5. Declare the following names for the active worksheet: 

Name Scope Reference 

EPFEmployee Workbook =11% 

EPFEmployer Payroll =EPFEmployee+1% 

 

6. Change the worksheet by using newly created names. Now the 

worksheet show be as below: 
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Name for multi-cells range 

EX1.3: Employee 

In this exercise you will learn more how to apply name to multi cells range. 

1. Insert a new worksheet 

2. Change the worksheet name to Empoyee. 

3. Prepare the worksheet as below: 

 
4. Create a new worksheet, and give it a name Lists. 

5. In the Lists worksheet 

a. Enter the data as shown 

b. Select cell B3:B7 

c. Click on the name box and type Departments followed by 

Enter. 

 

You just created a workbook scope name called Departments 

represents range B3:B7. While in the Lists worksheet, click the name 

box drop down, you should be able to see the name from the drop 

down list. 

 

6. Switch to Employee worksheet, click cell G3 
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7. Select tab Data and click Data Validation button. 

 

 

8. In the dialog box, select Allow: List option 

 

9. Key in the source as below: 
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10. Select the Input Message tab from the dialog box. Key in the input 

message a below: 

 

11. Select Error Alert tab from the dialog box. Key in the Error message 

as below: 

 

12. Press OK to end the dialog box. 

13. Back to worksheet, click on dropdown button: 
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Name Scoping, ambiguity and conflict resolution 

Name scope can be either 

 Worksheet 

 Workbook 

 

The name under worksheet scope only can be referred within the worksheet 

without qualifier 

 

The name under workbook scope can be referred within the entire 

workbook without qualifier 

 

 
 

Ground rule: Name must be unique under the same scope. 

 

For example, you can’t declare same names under same worksheet. 

However you can declare one name under workbook scope, and at the same 

time the same name under worksheet scope. 

 

If ambiguity occurs, worksheet scope will shadow workbook scope. But this 

rule can be overwritten by using qualifier. 

  

Worksheet Qualifier 
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EX1.4: Naming conflict resolution 

In this exercise you will learn how naming ambiguously is resolved. 

 

1. Create a name X with workbook scope with value 100. 

 
 

2. Create a local name X under worksheet Payroll with value 200. 

 
 

3. Under cell A1 of worksheet Payroll, type “=X” 

 
 

4. Press ESC to cancel the entry 
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Modify Name 

The name and it reference can be changed only by using name manager. 

But the name scope can’t be modified. The only way to change the scope 

is delete it and create again with the new scope. 

 

EX1.5: Modify Name 

In this exercise, you will learn how to modify names 

1. Run the Name Manager, select the workbook scope X, click Edit... 

 
2. Change the value to 150, click OK. 
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3. Select name X under the Payroll Scope. Select Edit… 

 
 

4. Change the name to Y. 

 
 

5. Discuss how to change the scope of name X to scope of Housing Loan 

worksheet? 
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Delete Name 

Name can be deleted by using Name Manager. 

 

EX1.6: Delete Name 

In this exercise, you will learn how to delete names 

1. Run Name Manager.  

 

2. Select names X and Y. (Control Click for multiple select) 

 
 

3. Press Delete. 
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Module 2 – Using Table Features 

Tables began as lists in the menu before version 2007, but they've become 

more powerful in the Ribbon versions. Converting a data range into a table 

extends functionality, which you can then use to work more efficiently and 

effectively. Here's a look at why you should consider using a table instead 

of an ordinary data range. 

 

Bear in mind that as handy as tables are, they don't accommodate all of 

Excel's features. For example, you can't use Excel's Subtotal feature with 

tables. When you need a feature that tables don't support, temporarily 

convert the table into a range. 

 

Some main benefits of using Table advantages over name ranges: 

1. Easy sorting and filtering 

2. Quick formatting 

3. Effortless data entry 

4. Automatic nomenclature 

5. Quick totals 

6. Always visible headers 

7. Formula autofill 

8. Dynamic charts 

9. One-click select 

10. Can allow access to various parts of the table 
 

Creating a Table 

Select the data range, then from the Home tab select: 

 

Common practice is try not to format the 

cell before apply table. The existing cell 

format will disturb the table color scheme. 

 

 

 

 

Delete Table 

1. Right-click the table, point to Table, 

and then click Convert to Range. 

2. On the Design tab, in the Tools group, 

click Convert to Range. 

 

Caution that after convert to range, although the table is removed, but the 

format still remain.   
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EX2.1: Create Table 

In this exercise, you will learn how to create table 

1. Switch to worksheet Lists. 

2. Select range B2:B7 

 
3. Select Home tab. Click Format as Table button. Select the table 

style you prefer. 

4. Make sure that My table has headers in the dialog box is checked. 

Press OK. 

 
5. Table is created. 

 
6. To turn off the filter. Unselect the Filter option under Data tab.
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Change Table Name 

When the table is created, it is given default name as Table#. Where # is 

number starts from 1 onward. But this default name is not meaningful to 

many applications. Therefore, normally is advisable to change it. 

There are various ways to change name 

1. Use Name Manager (Refer to next exercise) 

 

2. Select any part of the table, on the Design tab, in the Properties 

group: 

 
 

EX2.2: Rename Table 

Continue from previous exercises, in this exercise, you will learn how to 

rename table 

1. Run Name Manager. Select the newly created table, press Edit… 

 
 

2. Change the name to TblDepartment. 
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3. Take note that only table name can be modified. Table cannot be 

deleted via Name Manager, and Tables always have workbook 

scope. 

 

Sorting a Table 

1. Right click any table column, select Sort and followed by the sort 

option 

2. From Data ribbon tab, Sort & Filter group: 

 

Filtering a Table 

1. Right click any table column, select Filter and followed by the sort 

option 
2. From Data tab, Sort & Filter group: 

 

Working with the Total Row 

You can use Total Row to apply aggregate function to individual column in 

the table. 

1. Right click table, select Table and followed by Totals Row option 

 

2. From Design tab, Table Style Options group: 

 
 

3. Alternatively, you can use right-click option: 
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Creating a Calculated Column 

New table columns can be created. These columns can derive value by 

referring to other columns in the same table. We call these columns as 

Calculated Column. 

 

 
You will experience how to create this kind of columns later in other 

exercises. 

 

Formatting a Table 

Table can apply preset style to save efforts in formatting data. Before create 

table advisable to clear all formatting of the range. Otherwise the existing 

format will disturb the selected style. 

 

To change table style, go to Home tab, select style from Format as Table 

under Styles group.  

 

The other way is change the style from the Design tab, select style under 

Table Styles group. 
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Referring to different parts of table 

Once table is created, data from table can be referred in the cell formula.  

 

We can refer to various part of the table: 

Part Example 

Table Data TblEmployee 

Table Header TblEmployee[#Headers] 

Table Totals Row TblEmployee[#Totals] 

Entire Table TblEmployee[#All] 

Entire Column TblEmployee[Gender] 

 

EX2.3: Use Table Data in validation (Part-1) 

The parts of table can be considered as range in many cases. Refer to 

worksheet Lists, we created both name Departments and table data 

TblDepartment. Both are referring to range B3:B7. 

 

Previously we applied named range (Departments)validation of cell G3 

under Employee worksheet. Since Departments and TblDepartment 

both refer to same range, can we substitute Departments with 

TblDepartment in the list data validation of cell G3 under Employee 

worksheet? 

 

Let’s give it a try: 

1. Switch to worksheet Employee. 

2. Select Data tab, select Data Validation. 

3. Change the Source under Settings tab to “=TblDeppartment”, press 

OK. 
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4. You will receive the following error message: 

 
Although named range and table parts can be use interchangeable in 

many cases, however this case will fail. Table cannot be used directly 

under validation source. 

 

5. Since table data cannot be use directly, we can use indirectly. Try 

change the source to 

 
Beware that the TblDepartment must be enclosed in a pair of double 

quote marks. 

INDIRECT is one of the complex functions from Excel. 

 

6. Press OK. Test it by clicking the dropdown button 

 
7. Now, delete the Departments name from Name Manager. Test the 

validation again. 

 

8. Switch to Lists worksheet, select cell B7 (Sales),press Tab key, key 

in R&D. 

 
9. Switch back to Employee worksheet, test the validation again. 

 

The advantage of using table data for validation compare to named range 

is, if the list of data change in future, table data approach does not require 

to modify the reference from Name Manager as needed by the named 

range approach.  
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Use Table Data in validation (Part-2) 

The previous approach is adequate when the table only consists of one 

column. But tables in Excel can consist of multiple columns. 

 

So, what is the impact to the previous approach?  

Assuming we need to add more data (columns) to the TblDepartment 

table. 

1. Who is the department head? 
2. How many employees in the each department? 

 

 Let’s try the following steps: 

1. Switch to Lists worksheet. Select cell C2 and type Head then press 

enter. 

 
New column is inserted automatically (if cell C3:C8 are empty) 
 

2. Add another column with header No. of Employees. Complete the 

data as below: 

 
 

3. Now, switch Employee worksheet to the validation again. 
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Can you explain why you received the above validation list? 

 

4. Now while selecting cell G3, select Data tab, click Data Validation. 

 

5. Change the source to =INDIRECT("TblDepartment[Depatment 

Name]"). 
 

 
 

6. Press OK. Test the validation again. 
 

7. Discuss why it is a good practice to include column header in the 

validation rule even for the single column table? 
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Module 3 – Working with Formatting  

 

Applying Conditional Formatting 

Conditional formatting allows you to automatically apply formatting—such 

as colors, icons, and data bars—to one or more cells based on the cell value. 

To do this, you'll need to create a conditional formatting rule. 

 

 

Formatting based on Cells Values 

Color code your data will provide special visual effect in analyzing data. 

You can let Excel show format of your choice when data fulfill certain 

criteria. 

To do this, Select 

Home Tab → Conditional Formatting→ New Rule… 

Under New Formatting Rule dialog box,  

1) Select Format only cell that contain 
2) Select equal to  
3) Key in the value 
4) Press Format… button 
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Now you can decide the format that you want. 

 

Press OK to complete the formatting.  
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Ensure that the preview format is what you want, press OK to End.  

 

Formatting based on Formula 

If the conditional options provided are not sufficient to handle some 

special situations, you can use formula to decide the formatting. 

Under New Formatting Rule dialog box,  

1) Select Use a formula to determine which cells to format 
2) Key in the formula (The formula must return True or False) 
3) Press Format… button 
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Other Conditional Formatting (bars, scales, icons) 

Condition Formatting in Excel also provides some others attractive 

formatting options such as 

Data Bars 

 

Color Scales 

 

Icon Sets 
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EX3.1: Using Data Bar 

In this exercise you will learn how to use Data Bar Conditional Formatting. 

 

1. Under Employee worksheet, select cell I2 then type header Chart. 

Press Enter. A new column is created. 

 
 

2. While under cell I3, type = then select cell H3. 

 
 

3. Press Enter. 
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4. Select range I3:I15, select Home tab, Conditional Formatting, 

Data Bars. And the bar style. 

 
 

5. While still selecting range I3:I15, select Conditional Formatting, 

Manage Rules… 
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6. In the dialog box, select Data Bar format then click Edit Rule… 

 
7. In the next dialog box. Change the setting below: 

 
 

8. Press OK. Back to previous dialog box, press Apply then OK to end 

the dialog box. 

 

9. Discuss your final result. 
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EX3.2: Detect Duplicate data 

Imaging your tabular data consists of thousands of row, and some column 

must have unique value. How can you detect duplicate value entered? 

 

In this exercise you will learn how to detect duplicate values during data 

entry by using conditional formatting. 

 

1. Switch to Employee worksheet. 

 

2. Select range B3:B15 of TblEmployee. 

 

3. Select Home tab, Conditional Formatting, New Rules… 
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4. In the New Formatting Rule dialog box, select Format only 

unique or duplicate values option, click Format… button 

 

5. In the Format Cells dialog box, select Font tab, Font style click 

Bold, Color select Yellow. 
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6. While still in the Format Cells dialog box, select Fill  tab, select 

Background Color as Red. Click OK. 

 
 

7. Click OK again to end the Format Cells dialog box. 

 

8. Try to add new row by intentionally key in existing EID. 
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9. Discuss your observation. 

 
 

10. Delete the newly created row by right click the new row, then select 

Delete, Table Rows. 
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Module 4 – Working with Data Validation 

 

Using Data Validation 

It is a good practice to prevent user enter unacceptable data by using Data 

Validation. 

 
 

Entry guide 

You can provide guide during user enter data. 

 

 

Custom Error Message 

Customize error message is important to let user know why they are wrong. 
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Creating and Using Custom Formats 

Besides predefined format, custom formats can be defined for special 

cases. 

1. Right-click on the cell(s) 

2. Select Format Cells… 

 
 

3. In the Format Cells dialog box, select Custom format 
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Using the Quick Analysis Tool 

You can use the new Quick Analysis Tool in Excel to easy add conditional 

formatting, charts, totals, and tables to an Excel spreadsheet. 

 New feature that lets you access data analysis tools easily 

 Microsoft's research showed that many Excel users were simply not 

aware of the data analysis tools available in Excel 

 Many users are reluctant to create charts or tables in Excel because 

they are worried about being to modify them later 

 The Quick Analysis Tool puts data analysis features at your fingertips, 

as well as options for modifying these elements after you add them 

to your spreadsheet 

 

Using Table for Validation 

Common practice is to design validation rules for one row in the table. Every 

new row created later will automatically inherit the same validation. 

 

Exception cases where data validation will fail 

Validation on take effect during user entry. But there are few scenarios 

validations will not take action. For example: 

 Copy and paste 

 Value assign by VBA code 
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EX4.1: Various types of validation 

“Garbage in garbage out” means is data is incorrect, information will be 

invalid. 

 

During data entry, it is very common data entered wrongly. To prevent 

invalid data, we can use data validation. 

 

This exercise will provide different data validation alternatives 

 

1. Switch to Employee. 

 

2. Cell D3 is about Age. Add validation 

 
 

Input guide: Valid age to be employee in Malaysia is in between 16 

to 60 (inclusive) 
 

Error Message: Invalid Employee Age! 
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3. Cell E3 is about Basic Salary. Add validation 

 
Input guide: Minimum salary in Malaysia is $900 

Error Message: Invalid Basic Salary! 

 
4. Cell F3 is about Gender. Add validation 

 
Input guide: Select gender from the list. 

Error Message: Invalid Gender! 
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EX4.2: Adding calculated column 

In this exercise you will learn how to add calculated column in the table. 

1. Highlight cell B2:G3 of Employee worksheet. 

 
 

2. Create a new table (with headers). Change the table name as 

TblEmployee. 

 

3. Hide the filter buttons. 

 
 

4. Select cell G3, press Tab to create a new row. 

 
 

5. Complete the table data below: 

 
 

6. Select cell H2, type header Monthly Salary. Press Enter. 
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7. Select cell H3, and key the following (but don’t press enter yet) 

 
 

8. While still in the entry, select cell E3. You should get the following: 

 
 

9. Press Enter to confirm the formula. 

 
 

 
10. Select range H3:H15, Select Home tab, select $ (currency format). 
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Module 5 – Prevent invalid entry with Controls  

To prevent user making mistake during data entry always a good strategy 

in improving quality of the workbook.  In this module you will learn how to 

use form controls and some special techniques to construct less error prune 

and high quality worksheet for data entry.  

 

What is Controls? 

Worksheet with Form and ActiveX controls. A worksheet is a type of form that 

enables you to enter and view data on the grid, and there are several control-like 

features already built-in to Excel worksheets, such as comments and data 

validation. 

 

You use Form controls when you want to easily reference and interact with cell 

data without using VBA code, and when you want to add controls to chart sheets. 

For example, after you add a list box control to a worksheet and linking it to a cell, 

you can return a numeric value for the current position of the selected item in the 

control. You can then use that numeric value in conjunction with the INDEX 

function to select different items from the list. 

 

The following methods show how to use list boxes, combo boxes, spin buttons, 

and scroll bars. The examples use the same list, cell link, and Index function.  

 

 

To use the form controls in Excel 2010, you have to enable the Developer tab. 
To do this, follow these steps: 

1. Just Click File, and then click Options. 
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2. Click Customize Ribbon in the left pane. 

 

3. Select the Developer check box under Main Tabs on the right, and then click OK. 

 

 

4. Back to worksheet view, now you should be able to see the Developer Tab. 
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Problems with text entry. 

Let’s consider a scenario where you are required to create a model to calculate 

the total cost of an oversea order. The order needs to consider the following: 

1) Include Unit Price 

2) Include Quantity 

3) Consider Discount 

4) Some products need to include GST 

5) Product has different mode of delivery with different cost. 

6) Different destination countries have different tax percentage. 
 

Prepare a new worksheet “Tables” and create 2 new tables as shown below: 

 
 

Create a new Worksheet with “Data Entry”. Prepare the worksheet to hold the 

calculation model as below (Formula View): 

 
 

Discuss with the class, what are the possible mistake users will make during data 

entry for this model? 

 

How are you going to improve the model based on what you have learnt so far?  
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Handle Yes/No value with Check-Box 

From the Developer Tab select checkbox control: 

 
 

Drag select to create the check box beside GST cell: 

 

 
 

Double click the check box caption and rename it as: 

 

 
 

Right click to select Format Control… 

 
In cell link, type the GST? 

 
Unselect the check box by clicking any other place in the worksheet, then select 

the check box to observe what happening. 
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Select one out of many with Radio-Button 

Select Group Box from Developer Tab:  

 
Change the caption: 

 
Select Radio Button: 

 
Create by dragging inside the group box, and change the caption: 

 
Repeat for the other two delivery modes, then Control +  Right Click to select one 

by one: 
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Go to Format tab, then select Align Left: 

 
Then select Vertically:  

 
While the radio button still under selection, Control + Right Click to select the 

group box as well: 

 
While under selection, right click to select Group: 

  
You need to do this step slowly. As new comer, you might need to practice many 

times. The purpose of grouping radio button under group box so that you can have 

multiple set of radio buttons in the same worksheet. Without group box and 

grouping, all radio buttons under the worksheet are considered belong to the same 

group. 
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Now right click on any radio button in the group, select Format Controls… 

 
Now, type in DeliveryBy name in to the Cell link under Control Tab of Format 

Control Dialog box: 

 
 

Press OK. 

Unselect the radio button group by clicking elsewhere. 

Now select the radio button option. Discuss your observation. 

 

Change the formula of cell SubTotal4 to: 

 

Use Combo-Box and List-Box 

If there are too many options to choose from, perhaps radio button is not 

adequate. Combo box and list box also offer user to select one out of many options 

by using lesser space. 

 

Select Combo Box from the Developer Tab: 
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Place it just under the radio button group: 

 
Create a new Name: 

 
 

Change the formula of cell Total to: 

 
Right click on the combo box, and select the Format Control… 
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In the Control tab of Format Control dialog box, fill in the Input range and Cell 

link as below: 

 
 

Now select elsewhere, then click on the drop down button of the combo-box. Make 

Select any country and observe what will happen? If any problem, discuss How to 

fix it? 

Increase and decrease value with Spin Button 

Select Spin Button from Developer Tab:  

 

 
 

Centralize cell Quantity, and place the Spin Button as shown below: 

 
 

Under the Format Control of this Spin Button, set the following: 
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Increase and decrease value with Scrollbar 

Select Scrollbar from Developer Tab:  

 
Drag to create a new Scrollbar: 

 

 

 

 

Format the Scrollbar: 

 
 

Now you completed in adding all necessary controls. Below are the relationships between 

controls and the link cells: 
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Techniques to hide cell values 

To hide the cell value from display, you can format the cell as below: 

 
 

Techniques to prevent user direct data entry  

You can do the following: 

1) Lock all cells in the worksheet. 

2) Those cell you want the user to change or use by control via cell links 
unlock it. 

3) Hide the link cells and other cell value for intermediate calculation. 

4) Place controls to cover those link cells. 

5) Protect the worksheet with password. 
 

By applying this techniques, the final result is as below: 
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Different between Form and ActiveX Controls 

Form controls are simple. But ActiveX controls provide more attributes and 

programming capabilities. 

 

One major difference that is important to know is that ActiveX controls show up 

as objects that you can use in your code- try inserting an ActiveX control into a 

worksheet, bring up the VBA editor (ALT + F11) and you will be able to access the 

control programmatically. You can't do this with form controls (macros must 

instead be explicitly assigned to each control), but form controls are a little easier 

to use. If you are just doing something simple, it doesn't matter which you use 

but for more advanced scripts ActiveX has better possibilities. 

 

ActiveX is also more customizable. 

 

The Form controls are baked into Excel itself. The ActiveX controls are loaded from 

separate DLLs. You can add extra ActiveX controls, not Form controls 
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Module 6 – Important Functions  

Excel provides many built in functions to make your life easier. In this 

module we will explore some of the important functions that commonly 

used in managing data.  

TEXT Function 

The TEXT function converts a numeric value to text and lets you specify the 

display formatting by using special format strings. This function is useful in 

situations where you want to display numbers in a more readable format, 

or you want to combine numbers with text or symbols. For example, 

suppose cell A1 contains the number 23.5. To format the number as a dollar 

amount, you can use the following formula: 

 

=TEXT(A1,"$0.00") 

 

In this example, Excel displays $23.50. 

 

You can also format numbers by using the commands in the Number group 

on the Home tab of the Ribbon. However, these commands work only if the 

entire cell is numeric. If you want to format a number and combine it with 

other text, the TEXT function is the best option. For example, you can add 

text to the preceding formula: 

 

=TEXT(A1,"$0.00") & " per hour" 

 

Excel displays $23.50 per hour. 

 

The TEXT function syntax has the following arguments: 

 

TEXT(value, format_text) 

 

 value    Required. A numeric value, a formula that evaluates to a 

numeric value, or a reference to a cell containing a numeric value. 

 format_text    Required. A numeric format as a text string enclosed 

in quotation marks, for example "m/d/yyyy" or "#,##0.00". See the 

following sections for specific formatting guidelines. 
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IF 

Use the IF function, one of the logical functions, to return one value if a 

condition is true and another value if it's false. 

 

IF(logical_test, value_if_true, [value_if_false]) 

 

For example: 

 

=IF(A2>B2,"Over Budget","OK") 

 

=IF(A4=500,B4-A4,"") 

 

ERROR Function 

The Excel Error.Type function receives an error value and returns an 

integer, that tells you the type of the supplied error. 

 

The syntax of the function is:  

 

ERROR.TYPE( error_val ) 

 

Where the supplied error_val is a value (or a reference to a cell containing 

a value), that you want to return the error type of. 

 

The integers returned by the Excel Error.Type function, and their 

corresponding error types are listed in the table below: 

1 #NULL! 

2 #DIV/0! 

3 #VALUE! 

4 #REF! 

5 #NAME? 

6 #NUM! 

7 #N/A 

#N/A Anything else 

 

The following spreadsheets show four examples of the Error.Type function. 
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LOGICAL Function 

Excel logical functions include the boolean operators and conditional tests, 

which will be an essential part of many working spreadsheets. 

 

Boolean Operator Functions 

AND Tests a number of user-defined conditions and returns 

TRUE if ALL of the conditions evaluate to TRUE, or FALSE 

otherwise 

OR Tests a number of user-defined conditions and returns 

TRUE if ANY of the conditions evaluate to TRUE, or 

FALSE otherwise 

XOR Returns a logical Exclusive Or of all arguments (New in 

Excel 2013) 

NOT Returns a logical value that is the opposite of a user 
supplied logical value or expression 

(ie. returns FALSE is the supplied argument is TRUE and 

returns TRUE if the supplied argument is FALSE) 

 

 

Example 

 

The following spreadsheets show three examples of the Excel And function. 

 

 
 

Note that, in the above example spreadsheet: 

 

 the function in cell C1 evaluates to TRUE, as BOTH of the supplied 

conditions are TRUE; 

 the function in cell C2 evaluates to FALSE, as the third condition, 

B2>12, is FALSE; 

 the function in cell C3 evaluates to FALSE, as ALL of the supplied 

conditions are FALSE. 
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VLOOKUP and HLOOKUP functions 

VLookup is Excel look up function for tabular data range. It always lookups 

from the first column of the tabular data range from top-down (Therefore 

so called vertical lookup). The function caller can specifies the data from 

which column should be return upon successful lookup. 

 

Basically VLookup has two very different types of matching during the 

lookup process. 

1. Exact Match 
2. Approximate/Closest Match 

 

The usage of these matching is very different. 

VLookup Syntax & Rules 

Syntax: VLOOKUP(lookup_value, table_array, col_index, range_lookup) 

 

Parameter Description 

Lookup_value   The value to search in the first column of the table 

array (array: Used to build single formulas that 

produce multiple results or that operate on a group 

of arguments that are arranged in rows and 
columns. An array range shares a common 

formula; an array constant is a group of constants 

used as an argument.).  

Lookup_value can be a value or a reference.  

If lookup_value is smaller than the smallest value 

in the first column of table_array, VLOOKUP 

returns the #N/A error value. 

Table_array Two or more columns of data. Use a reference to 

a range or a range name. The values in the first 

column of table_array are the values searched by 

lookup_value. These values can be text, numbers, 

or logical values. Uppercase and lowercase text are 

equivalent. 

Col_index_num  The column number in table_array from which the 

matching value must be returned. A 

col_index_num of 1 returns the value in the first 

column in table_array; a col_index_num of 2 

returns the value in the second column in 

table_array, and so on. If col_index_num is: 

 Less than 1, VLOOKUP returns the #VALUE! 

error value. 

 Greater than the number of columns in 

table_array, VLOOKUP returns the #REF! 

error value. 
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Range_lookup   A logical value that specifies whether you want 
VLOOKUP to find an exact match or an 

approximate match: 

 If TRUE or omitted, an exact or approximate 

match is returned. If an exact match is not 

found, the next largest value that is less than 

lookup_value is returned.  

 

The values in the first column of table_array 

must be placed in ascending sort order; 

otherwise, VLOOKUP may not give the 

correct value. For more information, see Sort 

data. 
 

 If FALSE, VLOOKUP will only find an exact 

match. In this case, the values in the first 

column of table_array do not need to be 

sorted. If there are two or more values in the 

first column of table_array that match the 

lookup_value, the first value found is used. 

If an exact match is not found, the error 

value #N/A is returned. 

 

Remarks: 

 When searching text values in the first column of table_array, ensure 
that the data in the first column of table_array does not have leading 

spaces, trailing spaces, inconsistent use of straight ( ' or " ) and curly 

( ‘ or “) quotation marks, or nonprinting characters. In these cases, 

VLOOKUP may give an incorrect or unexpected value.  

 When searching number or date values, ensure that the data in the 

first column of table_array is not stored as text values. In this case, 

VLOOKUP may give an incorrect or unexpected value. For more 

information, see Convert numbers stored as text to numbers. 

 If range_lookup is FALSE and lookup_value is text, then you can use 

the wildcard characters, question mark (?) and asterisk (*), in 

lookup_value. A question mark matches any single character; an 

asterisk matches any sequence of characters. If you want to find an 

actual question mark or asterisk, type a tilde (~) preceding the 
character. 
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VLookup Example with an Exact Match 

When the parameter Range_lookup value is set to False, VLOOKUP will 

only find an exact match. 

 

EX6.1: VLookup (Exact Match) 

In this exercise you will learn how to use VLookup exact match to retrieve 

data from other table. 
 

Consider the case where company need to know the KPI of each employee. 

A new table will be created. 

 

1. Create a new worksheet with name KPI. 

 

2. Prepare the following table 

 
 

3. Discuss what are the issues if the user needs to key in employee 

name? 

 

4. Prepare a column formula for cell C3 

 
 

5. Add data validation to cell B3 
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6. Try to select different EID 

 
 

7. Discuss your observation 

 

8. Try to delete cell B3’s value. Discuss your observation 

 

9. Convert the tabular data to table and name it as TblKPI. 

 

10. Try to add few new record, identify any problem occurs and suggest 

solution. 
 

11. How to highlight duplicate EID selection? 
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VLookup Example with the Closest Match 

When the parameter Range_lookup value is set to True, VLOOKUP will 

perform approximate match. 

 

EX6.2: VLookup (Approximate Match) 

From the previous created table TblKPI, the management needs to make 

decision about the average performance of each employee based on the 
table below: 

Average Performance Action 

Below 40% Warning Letter 

40% to less than 70% (No Action) 

70% to less than 80% Increase Salary 

80% to less than 90% Promotion 

90% onward Increase Salary + Promotion 

 

A new column with header Action will be added to TblKPI. The value of this 

column will be derived from column Average and the abovementioned 

table.  

1. Create a new table with name TblAction under worksheet Lists. 

 

 

2. Switch to worksheet KPI. Prepare the data in the TblKPI table. 

 
 

3. Add new column Action to table TblKPI under worksheet KPI. 
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4. Add column formula to column Action of table TblKPI. 

 

 

5. Discuss your observation. 

 

6. Select cell I6, press TAB key to generate new row. 

 
  

Beware that we still have these few problems. 

 

Fix Your VLookup Error 

Sometime we want to silent about unsuccessful lookup or error generated 

from calling the VLookup function. In Excel 2007 you can use the following 

approaches: 

1. Check the data before calling VLookup 

 
2. Let the VLookup generate error and substitute the error with 

something else. 

 

  

This part of formula will be added 

by just click on cell H3 
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EX6.3: Hiding VLookup Error 

As you realized, there are imperfection from the VLookup column formulas from 

the previous exercises. In this exercise, you will learn how to apply the mentioned 

two VLookup error handling approaches. 

1. Replace column formula from cell C3 to  

 

 
 

2. Replace column formula from cell H3 to  

 

 
 

3. Replace column formula from cell I3 to  

 

 
 

4. Discuss your observation 

 

What is HLookup? 

The HLookup function behave similar to VLookup. The different is instead 

of lookup from the first column vertically, HLookup will lookups the tabular 

data from the first row horizontally.  

 

Due to the nature of tabular data, VLookup is more commonly use. 
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COUNT related Functions 

 

The Excel Count and the Excel Counta functions both count the number of 

values within a supplied set of values or range of cells. 

 

The two functions differ in the following ways: 

 

 The Count function returns the count of numeric values (includes 

numbers and dates); 

 The Counta function returns the count of all non-blank values 

(includes numbers, dates, text values, logical values and errors). 

 

The Excel Count function returns the count of numeric values in a supplied 

set of cells or values. This count includes both numbers and dates. 

 

The syntax of the function is: 

 

COUNT( value1, [value2], ... ) 

 

Where the arguments, value1, [value2], etc, can be any values, arrays of 

values, or references to cell ranges. 

 

In recent versions of Excel (2007 and later), you can enter up to 255 value 

arguments to the Excel Count function, each of which may be an array of 

cells or values. However, in Excel 2003, the function can only handle up to 

30 arguments. 

 

Numbers and dates are always counted as numeric values by the Excel 

Count function. However, text representations and logical values are 

counted differently, depending on whether they are supplied as a value in 

a range of cells, or if they are supplied directly to the function. 

 

The table below summarises which values are and which are not treated as 

numeric values by the Excel Count function: 

 

 Value Within a 

Range of Cells 

Value Supplied 

Directly to Function 

Numbers ARE counted ARE counted 

Dates ARE counted ARE counted 

Logical Values NOT counted ARE counted 

Text Representations 

of Numbers & Dates 

NOT counted ARE counted 

Other Text NOT counted NOT counted 

Errors NOT counted NOT counted 
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Example 1 - Values Supplied from a Range of Worksheet Cells 

In the following spreadsheet, the Count function is used to return the 

number of numeric values in one or more supplied ranges of cells. 

 

 
Note that, in the above example: 

 

 The numbers and the date 01/01/2015 are counted by the function. 

 The text value "text", the logical value FALSE, and the error value 

#N/A are not counted by the function. 

 The empty cells are not counted by the function. 

 

Example 2 - Values Supplied Directly to the Excel Count Function 

 

In the following spreadsheet, the Excel Count function is used to count the 

number of numeric values in sets of values supplied directly to the function. 

 
 

Note, in the above example: 

 

 The number 100 and the date 01/01/2015 are counted by the 

function. 

 The text representations of the number "100" & the date, 

"01/01/2015", and the logical value FALSE, are counted by the 

function. 

 The text string "text" and the error #N/A are not counted by the 

function. 
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The Excel Counta function returns the number of non-blanks within a 

supplied set of cells or values. 

 

The syntax of the function is: 

 

COUNTA( value1, [value2], ... ) 

 

Where the arguments, value1, [value2], etc, can be any values, arrays of 

values, or references to cell ranges. 

 

In recent versions of Excel (2007 and later), you can enter up to 255 value 

arguments to the Excel Counta function, each of which may consist of any 

number of cells or values. However, in Excel 2003 and earlier, the function 

can only handle up to 30 arguments. 

 

Note that, if a cell contains an empty text string or a formula that returns 

an empty text string, this cell is counted as a non-blank by the Counta 

function. 

 

Example 1 - Values Supplied from a Range of Worksheet Cells 

 

In the following spreadsheet, the Counta function is used to return the 

number of non-blank cells in one or more supplied cell ranges. 

 
 

Example 2 - Values Supplied Directly to the Excel Counta Function 

 

In the following spreadsheet, the Excel Counta function is used to return 

the number of non-blank values within a set of values that is supplied 

directly to the function. 
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The Excel Countblank function returns the number of blank cells in a 

supplied range. 

 

The syntax of the function is: 

 

COUNTBLANK( range ) 

 

Where the range argument specifies the range of cells in which you want 

to count blank cells. 

 

Note that, if a cell contains an empty text string or a formula that returns 

an empty text string, this cell is counted as a blank by the Countblank 

function. 

 

Examples 

 

In the spreadsheets below, the Excel Countblank function is used to 

calculate the number of blank cells in two different cell ranges. 
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The Excel Countif function returns the number of cells within a supplied 

range, that satisfy a given criteria. 

 

The syntax of the function is: 

 

COUNTIF( range, criteria ) 

 

Where the function arguments are as follows: 

Range The range of cells that should be tested against the supplied 

criteria and counted if the criteria is satisfied. 

Criteria A user-defined condition that is tested against each of the cells 

in the supplied range. 

 

The supplied criteria can be either: 

 

 a numeric value (which may be an integer, decimal, date, time, or 

logical value) (eg. 10, 01/01/2008, TRUE) 

or 

 a text string (eg. "Text", "Monday") 

or 

 an expression (eg. ">12", "<>0"). 

 

Note that if your criteria is a text string or an expression, this must be 

supplied to the function in quotes. 

 

Also note that the Excel Countif function is not case-sensitive. So, for 

example, the text strings "TEXT" and "text" will be considered to be equal. 

 

Example 1 

The following example shows the Excel Countif function used to count cells 

containing text strings, numerical values, dates or logical values in the data 

spreadsheet on the right. 
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The format and results of the functions are shown in the spreadsheets 

below.  

 

 
 

Example 2 

In the example below, the Excel Countif function is used to identify 

duplicates in a column containing reference numbers. The function works 

by counting the number of times the reference number in column A of the 

current row has occurred so far. 

 

Note that the function in this example uses a combination of relative and 

absolute cell references, so that, as the formula is copied down column B 

of the spreadsheet, the reference to A$2:A2 is automatically updated to 

A$2:A3 in row 3, A$2:A4 in row 4, etc. 

 

This ensures that only the repeated instances of a duplicate value are 

highlighted. I.e. The function does not highlight the first instance of a value. 

 
 

In the above example the Excel Countif function has, as expected, identified 

the duplicate reference in cell A5 of the spreadsheet. 
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The Excel Countifs function returns the number of entries (within one or 

more supplied arrays), that satisfy a set of given criteria. 

 

The function is new in Excel 2007, and so is not available in earlier versions 

of Excel. 

 

The syntax of the Countifs function is: 

 

COUNTIFS( criteria_range1, criteria1, [criteria_range2, criteria2], ... ) 

 

Where the function arguments are as follows: 

criteria_range1 

[criteria_range2], ... 

Arrays of values (or ranges of cells containing 

values) to be tested against the respective 

criteria1, [criteria2], ... 

 

(The supplied criteria_range arrays must all have 

the same length 

criteria1, 

[criteria2], ... 

The conditions to be tested against the values in 

criteria_range1, [criteria_range2], ... 

 

Up to 127 pairs of criteria_range and criteria arguments can be supplied to 

the function. 

 

Each of the supplied criteria can be either: 

 

 a numeric value (which may be an integer, decimal, date, time, or 

logical value) (eg. 10, 01/01/2008, TRUE) 

or 

 a text string (eg. "Name", "Sunday") 

or 

 an expression (eg. ">12", "<>0"). 

 

Note that if your criteria is a text string or an expression, this must be 

supplied to the function in quotes. 

 

Also note that the Excel Countifs function is not case-sensitive. So, for 

example, the text strings "TEXT" and "text" will be considered to be equal. 

 

Examples 

 

The spreadsheet below shows a set of exam results for a class of students. 

 

The Countifs function can be used to find the number of rows in the data 

set that satisfy conditions relating to the subject, score and gender. 
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This is shown in the examples below.  

 

Example 1 

If we want to know how many female test scores were greater than 60%, 

we could use the following formula: 

 

=COUNTIFS( B2:B13, "Female", D2:D13, ">60%" ) 

 

which gives the result 4. 

 

In this example, the formula has counted the number of rows where: 

 The entry in column B is equal to "Female" 

and 

 The entry in column D is greater than "60%".  

 

Example 2 

 

If we want to know how many science tests scores were less than 50%, we 

could use the formula: 

 

=COUNTIFS( C2:C13, "Science", D2:D13, "<50%" ) 

 

which gives the result 2. 
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SUM related functions 

 

The Excel SUM function adds together a supplied set of numbers and 

returns the sum of these values. 

 

The syntax of the function is: 

 

SUM( number1, [number2], ... ) 

 

where the number arguments are a set of numbers (or arrays of numbers) 

that you want to find the sum of. 

 

In current versions of Excel (Excel 2007 and later), you can enter up to 255 

number arguments to the Excel Sum function, but in Excel 2003, the 

function can only handle up to 30 arguments. However, each argument can 

consist of an array of values or a range of cells, each of which can contain 

many values. 

 

Numbers and dates are always counted as numeric values by the Excel Sum 

function. However, text representations and logical values are handled 

differently, depending on whether they are values stored in the cells of your 

spreadsheet, or they are supplied directly to the function. 

 

The table below summarises which values are included in the Excel Sum 

Function calculation, and which values are ignored or result in errors: 
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Examples 

 

The following spreadsheets show the Excel Sum function used to calculate 

the sum of the numbers 5, 6, 7, 8 & 9. In each of the five examples, the 

numbers are supplied to the Sum function in a different way. 

 
 

Note that, in the above example spreadsheets: 

 

 Each argument to the Sum function can be supplied as a single value 

or cell, or as an array of values or cells (note that in cell B2, the 

argument {5,6,7} is an array of numbers); 

 When supplied directly to the function, text representations of 

numbers are included in the Sum calculation (see the example in cell 

B4). 

If you get an error from the Excel Sum Function, this is likely to be the 

#VALUE! error:  

There are also conditional version of Sum related functions: 

Conditional Sums 

SUMIF Adds the cells in a supplied range, that satisfy a given 

criteria 

UMIFS Adds the cells in a supplied range, that satisfy multiple 
criteria (New in Excel 2007) 
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SUMPRODUCT 

The Excel SumProduct function returns the sum of the products of the 

corresponding values in a set of supplied arrays. 

 

The format of the function is: 

 

SUMPRODUCT( array1, [array2], [array3], ... ) 

 

where the array arguments are one or more arrays of numeric values that 

you want to sum the products of. 

 

Note that: 

 All of the supplied arrays must have the same dimensions; 

 If just one array is supplied, the function returns the sum of the 

values in that array. 

 Non-numeric values in the supplied arrays are treated as the value 

zero; 

 In current versions of Excel (Excel 2007 and later), you can provide 

up to 255 arrays of values to the SumProduct function, but in Excel 

2003, the function can only handle up to 30 arrays of values; 

 Arrays that are supplied directly to the SumProduct function should 

be surrounded by curly braces, with values in the same row separated 

by a comma and each row separated by a semicolon. An example of 

a vertical array is shown in cells C3 and C4 of the 'Formulas' 

spreadsheet below.  

 

Examples  

The spreadsheets on the right show 3 examples of the SumProduct 

function. 

 

Note that: 

 

 The examples in cells 

C3 and C4 show how 

the array arguments 

can be supplied 

directly, to the 

function, as well as in 

the form of arrays of 

cells; 

 The "text" value in 

cell C4 is treated as the 

value 0 by the 

Sumproduct function. 
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DATE & TIME functions 

Excel Date and Time Functions, which can be used to extract information 

from, and perform operations on, Excel dates and times. 

 

The functions listed below are grouped into categories, to help you to find 

the function you need. Note that some of the functions are new to Excel 

2010 or Excel 2013, so are not available in earlier versions of Excel. 

 

Creating Dates & Times 

DATE Returns a date, from a user-supplied year, month and 

day 

TIME Returns a time, from a user-supplied hour, minute and 

second 

DATEVALUE Converts a text string showing a date, to an integer that 

represents the date in Excel's date-time code 

TIMEVALUE Converts a text string showing a time, to a decimal that 

represents the time in Excel 

 

 

Current Date & Time 

NOW Returns the current date & time 

TODAY Returns today's date 

 

 

Extracting The Components of a Time 

HOUR Returns the hour part of a user-supplied time 

MINUTE Returns the minute part of a user-supplied time 

SECOND Returns the seconds part of a user-supplied time 

 

 

Extracting The Components of a Date 

DAY Returns the day (of the month) from a user-supplied 

date 

MONTH Returns the month from a user-supplied date 

YEAR Returns the year from a user-supplied date 

WEEKNUM Returns an integer representing the week number (from 

1 to 53) of the year from a user-supplied date 

ISOWEEKNUM Returns the ISO week number of the year for a given 

date (New in Excel 2013) 

WEEKDAY Returns an integer representing the day of the week for 

a supplied date 
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Performing Calculations with Dates 

EDATE Returns a date that is the specified number of 

months before or after an initial supplied start 

date 

EMONTH Returns a date that is the last day of the month 

which is a specified number of months before or 

after an initial supplied start date 

WORKDAY Returns a date that is a supplied number of 

working days (excluding weekends & holidays) 

ahead of a given start date 

WORKDAY.INTL Returns a date that is a supplied number of 

working days (excluding weekends & holidays) 

ahead of a given start date, using supplied 
parameters to specify weekend days (New in 

Excel 2010) 

DAYS Calculates the number of days between 2 dates 

(New in Excel 2013) 

DAYS360 Calculates the number of days between 2 dates, 

based on a 360-day year (12 x 30 months) 

NETWORKDAYS Returns the number of whole networkdays 

(excluding weekends & holidays), between two 

supplied dates 

NETWORKDAYS.INTL Returns the number of whole networkdays 

(excluding weekends & holidays), between two 

supplied dates, using parameters to specify 
weekend days (New in Excel 2010) 

YEARFRAC Calculates the fraction of the year represented by 

the number of whole days between two dates 

 

EX6.4: Simplified Age Calculation in Excel 

The simplest way to calculate age in Excel is to subtracting the current date from 

the birth date and divide this result by 365.25 (the average number of days in a 

year). This resulting value is then truncated to an integer using the Excel Int 

function. This is shown below: 

 

 
 

While the above formula works in over 99% of cases, inaccuracies are introduced, 

due to the 'average' day count of 365.25. For example, if the birth date is 01-Mar-

2000 and the current date is 01-Mar-2010, the above formula gives the incorrect 

age 9, when the correct age is 10. 
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Similar inaccuracies can also occur if you use the most frequent day count of 365. 

Therefore, if you want 100% accuracy in you Excel age calculation, you need to 

use the following, more complex formula. 

 

Accurate Age Calculation in Excel 

Although the following formula may appear to be complicated, this level of 

complexity is necessary if you want to accurately calculate age in Excel. The 

formula uses the Excel date functions, along with a nested Excel If function: 

 
 

The above formula initially calculates the number of years between the current 

date and the birth date. However, the resulting value needs to be adjusted, 

depending on whether the birthday has passed during the current year. To do this, 

we have used the Excel If function to first check if the current month is less than 

or greater than the month of the birth date. If the month is the same, the days of 

the month are compared, to determine whether the birthday has been passed 

during the current year. 

 

Use of the Today Function to Automatically Update an Age Calculation in 

Excel 

 

If you want your age formula to update automatically, depending on the current 

date, this can be done using the Excel Today function. This function simply returns 

the current date. Therefore, if you replace the value in cell B2 of the above 

spreadsheet, with the formula =TODAY(), the age formula in cell B3 will update 

automatically with the current date. 

 

Alternatively, you could replace every reference to cell B2 with the Today function, 

so that the Excel age calculation formula becomes: 

 

 

  



 

80  

Information Functions (ISNA, ISEVEN, ISERR…) 

 

These functions mainly provide information about the contents of cells, 

such as data type, although Excel has also included functions that will 

return information about the formatting and location of cells. 

 

The functions have been grouped into categories, to help you to find the 

function you need. Selecting a function name will take you to a full 

description of the function with examples of use. 

 

Error Information Functions 

ISERROR Tests if an initial supplied value (or expression) returns 

an error and if so, returns TRUE; Otherwise returns 

FALSE 

ISERR Tests if an initial supplied value (or expression) returns 

an error (EXCEPT for the #N/A error) and if so, returns 

TRUE; Otherwise returns FALSE 

ISNA Tests if an initial supplied value (or expression) returns 

the Excel #N/A error and if so, returns TRUE; Otherwise 

returns FALSE 

ERROR.TYPE Tests a supplied value and returns an integer relating to 

the supplied value's error type 
 

 

Numerical Information Functions 

ISNUMBER Tests if a supplied value is a number, and if so, returns 

TRUE; Otherwise, returns FALSE. 

ISEVEN Tests if a supplied number (or expression) is an even 

number, and if so, returns TRUE; Otherwise, returns 

FALSE. 

ISODD Tests if a supplied number (or expression) is an odd 
number, and if so, returns TRUE; Otherwise, returns 

FALSE. 

N Converts a non-number value to a number, a date to a 

serial number, the logical value TRUE to 1 and all other 

values to 0 

 

 

Function Returning a Constant Value 

NA Returns the Excel #N/A error 
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Other Data Type Functions 

ISBLANK Tests if a supplied cell is blank (empty), and if so, 

returns TRUE; Otherwise, returns FALSE 

ISLOGICAL Tests if a supplied value is a logical value, and if so, 

returns TRUE; Otherwise, returns FALSE 

ISTEXT Tests if a supplied value is text, and if so, returns TRUE; 

Otherwise, returns FALSE 

ISNONTEXT Tests if a supplied value is text, and if it is NOT, returns 

TRUE; Otherwise, returns FALSE 

ISREF Tests if a supplied value is a reference, and if so, returns 

TRUE; Otherwise, returns FALSE 

ISFORMULA Tests if a supplied cell contains a formula and if so, 

returns TRUE; Otherwise, returns FALSE (New in Excel 
2013) 

TYPE Returns information about the data type of a supplied 

value 

 

 

General Information Functions 

CELL Returns information about the contents, formatting or 
location of a given cell 

SHEET Returns the sheet number relating to a supplied 

reference (New in Excel 2013) 

SHEETS Returns the number of sheets in a reference (New in 

Excel 2013) 

INFO Returns information about the the current operating 
environment 

 

 

Note that some of the Information functions are new in Excel 2013 and so 

are not available in earlier versions of Excel. 

 

Below are more details of few of these functions 
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The Excel ISNA function tests if an initial supplied expression (or value) 

returns the Excel #N/A Error, and if so, returns TRUE; Otherwise the 

function returns FALSE. 

 

The format of the function is: 

 

ISNA( value ) 

 

Where the value argument is the expression or value to be tested. 

 

The following spreadsheets show several examples of the Excel Isna 

function. 

 
The above examples use different argument types, including: 

 Simple values (see cells B1 - B3); 

 Expressions (see cells B4 & B5); 

 Cell references (see cells B6 - B8). 

 

Note also that, in the above examples: 

 Although the expression in cell A7 is an error, this is not the #N/A 

error, so the Isna function in cell B7 returns FALSE. 

 In cell B5, the VLookup function cannot find the value '10' in column 

A of the spreadsheet, and so returns the #N/A error. Therefore, the 

Isna function returns TRUE. 
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The Excel Iserror function tests if an initial supplied expression (or value) 

returns an Excel Error, and if so, returns the logical value TRUE; Otherwise 

the function returns FALSE. 

 

The syntax of the function is: 

 

ISERROR( value ) 

 

Where the value argument is the expression or value to be tested. 

 

The following spreadsheets show several examples of the Excel Iserror 

function. 

 

 
 

In the examples above, the arguments to the Iserror function calls are: 

 Simple values in cells B1 - B3; 

 Expressions in cells B4 & B5 (note the division by zero in cell B4 will 

produce the #DIV/0! error); 

 Cell references in cells B6 & B7. 
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Module 7 – Data Filtering and Grouping  

If your worksheet contains a lot of content, it can be difficult to find 

information quickly. Filters can be used to narrow down the data in your 

worksheet, allowing you to view only the information you need. 

 

To filter data: 

 

In following example, we'll apply a filter to an equipment log worksheet to 

display only the laptops and projectors that are available for checkout. 

 

1. In order for filtering to work correctly, your worksheet should include 

a header row, which is used to identify the name of each column. 

In our example, our worksheet is organized into different columns 

identified by the header cells in row 1: ID#, Type, Equipment Detail, 

and so on. 

 
2. Select the Data tab, then click the Filter command. 

 
3. A drop-down arrow  The drop-down arrow will appear in the 

header cell for each column. 

 

4. Click the drop-down arrow for the column you want to filter. In our 

example, we will filter column B to view only certain types of 
equipment. 
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5. The Filter menu will appear. 

 

6. Uncheck the box next to Select All to quickly deselect all data. 

 
 

7. Check the boxes next to the data you want to filter, then click OK. 

In this example, we will check Laptop and Tablet to view only those 

types of equipment. 
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8. The data will be filtered, temporarily hiding any content that doesn't 

match the criteria. In our example, only laptops and tablets are 

visible. 

 
Filtering options can also be accessed from the Sort & Filter command on 

the Home tab. 
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 To apply multiple filters: 

 

Filters are cumulative, which means you can apply multiple filters to 

help narrow down your results. In this example, we've already filtered our 

worksheet to show laptops and projectors, and we'd like to narrow it down 

further to only show laptops and projectors that were checked out in 

August. 

1. Click the drop-down arrow for the column you want to filter. In this 

example, we will add a filter to column D to view information by date. 

 
2. The Filter menu will appear. 

 

3. Check or uncheck the boxes depending on the data you want to 

filter, then click OK. In our example, we'll uncheck everything except 

for August. 
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4. The new filter will be applied. In our example, the worksheet is now 

filtered to show only laptops and tablets that were checked out in 

August. 
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To clear a filter: 

 

After applying a filter, you may want to remove—or clear—it from your worksheet 

so you'll be able to filter content in different ways. 

1. Click the drop-down arrow for the filter you want to clear. In our 
example, we'll clear the filter in column D 

 
2. The Filter menu will appear. 

 
3. Choose Clear Filter From [COLUMN NAME] from the Filter menu. 

In our example, we'll select Clear Filter From "Checked Out". 

 
 

4. The filter will be cleared from the column. The previously hidden data 

will be displayed. 
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To remove all filters from your worksheet, click the Filter command on the 

Data tab. 

 

Filter By Color, Filter by Icon Sets 

Follow these steps to filter data by cell color / font color. 

1. Open a worksheet with Spreadsheets 2013. 

2. Select the range of cells you want to filter. 

3. Go to Home or Data tab, click on Autofilter. 

4. Click on the drop-down arrow in each cell of the first line in the 

selected range. In the autofilter option dialog, click on Filter by Color. 
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You can either filter the data by cell color or font color, in case you have 

formatted the cells by both cell color and font color. 

Click one color from the above font color and cell color list. For example, 

select the font color of Red. You will see the data is filtered like below: 

 

Remove Color Filter 

If you want to remove the color filter you have applied to the worksheet 

data, follow these steps to clear the filter from the worksheet. 

1. Click on the autofilter icon in the column header. 

2. In the autofilter option dialog, click on Clear. 

 

The filter is removed. If you want to reaply the filter, please go to Home or 

Data tab, click on AutoFilter option and choose Reapply from the drop-down 

list.  
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Advanced Filter 

If you need to filter for something specific, basic filtering may not give you 

enough options. Fortunately, Excel includes many advanced filtering tools, 

including search, text, date, and number filtering, which can narrow your 

results to help find exactly what you need. 

To filter with search: 

Excel allows you to search for data that contains an exact phrase, number, 

date, and more. In our example, we'll use this feature to show only Saris 

brand products in our equipment log. 

1. Select the Data tab, then click the Filter command. A drop-down 

arrow will appear in the header cell for each column. Note: If you've 

already added filters to your worksheet, you can skip this step. 

 
 

2. Click the drop-down arrow for the column you want to filter. In our 

example, we'll filter column C. 

 

3. The Filter menu will appear. Enter a search term into the search 

box. Search results will appear automatically below the Text Filters 

field as you type. In our example, we'll type saris to find all Saris 

brand equipment. 

 

4. When you're done, click OK. 
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5. The worksheet will be filtered according to your search term. In our 

example, the worksheet is now filtered to show only Saris brand 

equipment. 
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To use advanced text filters: 

Advanced text filters can be used to display more specific information, such 

as cells that contain a certain number of characters, or data that excludes 

a specific word or number. In our example, we've already filtered our 

worksheet to only show items with Other in the Type column, but we'd like 

to exclude any item containing the word case. 

1. Select the Data tab, then click the Filter command. A drop-down 

arrow will appear in the header cell for each column. Note: If you've 

already added filters to your worksheet, you can skip this step. 

 

2. Click the drop-down arrow for the column you want to filter. In our 

example, we'll filter column C. 

 
3. The Filter menu will appear. Hover the mouse over Text Filters, 

then select the desired text filter from the drop-down menu. In our 

example, we'll choose Does Not Contain... to view data that does 

not contain specific text. 
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4. The Custom AutoFilter dialog box will appear. Enter the desired 

text to the right of the filter, then click OK. In our example, we'll 

type case to exclude any items containing this word. 

 
 

5. The data will be filtered by the selected text filter. In our example, 

our worksheet now displays items in the Other category that do not 

contain the word case. 

 

 
 

Remove Duplicates 

In some situation duplicate data can cause problem to your information.  

To remove duplicates in Excel. 

1. Select your data 

2. Click any single cell inside the data set 

3. On the Data tab, click Remove Duplicates. 
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Subtotal 

The Subtotal command allows you to automatically create groups and use 

common functions like SUM, COUNT, and AVERAGE to help summarize your 

data. For example, the Subtotal command could help to calculate the cost 

of office supplies by type from a large inventory order. It will create a 

hierarchy of groups, known as an outline, to help organize your worksheet. 

Your data must be correctly sorted before using the Subtotal command, so 

you may want to review our lesson on Sorting Data to learn more. 

To create a subtotal: 

In our example, we will use the Subtotal command with a T-shirt order form 

to determine how many T-shirts were ordered in each size (Small, Medium, 

Large, and X-Large). This will create an outline for our worksheet with a 

group for each T-shirt size and then count the total number of shirts in each 

group. 

1. First, sort your worksheet by the data you want to subtotal. In this 

example, we will create a subtotal for each T-shirt size, so our 

worksheet has been sorted by T-shirt size from smallest to largest. 

 

2. Select the Data tab, then click the Subtotal command. 
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3. The Subtotal dialog box will appear. Click the drop-down arrow for 

the At each change in: field to select the column you want to 

subtotal. In our example, we'll select T-Shirt Size. 

4. Click the drop-down arrow for the Use 

function: field to select the function 

you want to use. In our example, we'll 

select COUNT to count the number of 
shirts ordered in each size. 

5. In the Add subtotal to: field, select 

the column where you want the 

calculated subtotal to appear. In our 

example, we'll select T-Shirt Size. 

6. When you're satisfied with your 

selections, click OK.  

 

7. The worksheet will be outlined into 

groups, and the subtotal will be listed 

below each group. In our example, the 

data is now grouped by T-shirt size, 
and the number of shirts ordered in that size appears below each 

group. 
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Data Grouping 

With a lot of content can sometimes feel overwhelming and even become 

difficult to read. Fortunately, Excel can organize data in groups, allowing 

you to easily show and hide different sections of your worksheet.  

 

To group rows or columns: 

1. Select the rows or columns you want to group. In this example, 

we'll select columns A, B, and C. 

 
2. Select the Data tab on the Ribbon, then click the Group command. 

 
3. The selected rows or columns will be grouped. In our example, 

columns A, B, and C are grouped together. 
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To ungroup data, select the grouped rows or columns, then click the 

Ungroup command. 

 

To hide and show groups: 

1. To hide a group, click the Hide Detail button . 

 
2. The group will be hidden. To show a hidden group, click the Show 

Detail button . 
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Module 8 – Data Consolidation  

By combining data from different places can produce important information 

as well.   

Consolidate According to the Position in an Excel Worksheet 

Identify Categories to Consolidate Excel Data 

Use Formulas to Consolidate Excel Data s 

Microsoft Office Excel comes with several features for customizing tables 

and charts full of important data. The program also offers efficient ways to 

combine and summarize data from multiple worksheets. Common methods 

to consolidate in Excel include consolidating by position, by formula and by 

using Excel’s Pivot Table feature.  

 

Consolidate According to the Position in an Excel Worksheet 

 

 Verify that data in each worksheet appear in list format. Make 

sure you have removed any blank columns and rows, and that each 

column is labeled with similar information. 

o Add and layout each column range to a separate worksheet. 

However, do not add the ranges to the master worksheet that 

you plan to consolidate. 
o Highlight each range, and name them by picking the Formulas 

tab, followed by the arrow located near Name a Range. Enter a 

name for the range in the Name box. 

 

 Prepare to consolidate Excel data. Click on the upper-left cell 

where you want to place your consolidated data from your master 

worksheet. 

o Go to the Data tab from the master worksheet, and then select 

the Data Tools group. Choose Consolidate. 

o Access the summary function feature from the Function box to 

create the settings for consolidating data. 
 

 Enter the names of your ranges in the Summary Function 

feature. Click Add to begin the consolidation process. 
 

 Update the consolidation. Choose the Create Links to Source Data 

box if you want to update source data automatically. Leave the box 

unchecked if you prefer to update consolidation data manually. 
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 EX8.1: Consolidate Data According to the Position in 

Worksheet 

In this exercise, you will learn how to consolidate data according to the 

Position in Worksheet. 

1. Create a new worksheet with name Q1 and prepare the contents as 

below: 

 
2. Once worksheet Q1 is completed, Copy to 3 more new worksheets 

and rename as Q2, Q3 and Q4 respectively. Change the contents for 

each of the newly clone worksheets with the following contents: 

Q2: 

 
Q3: 

 
Q4: 

 
 

3. Create another new worksheet with name Yearly. 

 
 

4. Switch to worksheet Yearly, select range B2:E4. 
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5. Select Data tab, and click the Consolidate button. 

 
 

6. In the Consolidate dialog box, make sure that 

a. Top row is cleared 

b. Left column is cleared  

c. Editing focus is in the Reference field 
 

 
 

7. While the dialog box still on, switch to worksheet Q1. 

 

8. Select range B2:E4 under worksheet Q1. Pay attention to the 

Reference field. Press Add button.  

 

 

9. Now the dialog box shows the reference to Q1’s range is added in to  
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All references list box. 

 

10. Next, while the dialog box still on, just select worksheet Q2 name 

tab, then press Add button. 

 

11. Repeat step 10 for Q3 and Q4. Now the Consolidate dialog box will 

looks like below: 

 
 

12. Press OK to close the Consolidate dialog box. Now the consolidated 

result done: 
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Consolidate Data by Linking 

Previous method will not update the consolidate data when the source data 

changed. In order to update automatically, try the following exercise 

 

 EX8.2: Consolidate Data by Linking 

In this exercise, you will learn how to consolidate data according to the 

Position in Worksheet. 

1. Switch to Yearly tab. Select range B2:E4 Click the Consolidate 
button under Data tab again. 

 

2. Check the Create links to source data 

 

3. Press OK button confirm the consolidation. 
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Consolidation with PivotTable Report 

Data consolidation also can be done with PivotTable. This feature allows 

you to consolidate Excel data from multiple ranges with the capability of 

reorganizing categories when necessary 

 

 EX8.3: Create a PivotTable report 

In this exercise, you will learn how to produce PivotTable report to 

consolidate data. 

1. Start the PivotTable and PivotChart wizard by pressing Alt+D+P 

(Press D then followed by P, not D and P together) on your keyboard.  

 
 

2. Choose Multiple Consolidation Ranges, then Next. 
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3. In the PivotTable and PivotChart Wizard select Create a page 

fields for me, and press Next. 

 
 

4. Select Range field. 

 
 

5. Switch to Q1 worksheet. Select range A1:E4. Press Next. 
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6. Repeat adding same range from worksheets Q2, Q3 and Q4. Press 

Next. 

 

 

7.  Select New worksheet, then press Finish. 

 
 

8. A PivotTable Report is created. 
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Module 9 – Using PivotTable  

PivotTable is one of the unique powerful feature provided by Excel. It is one 

of the main reason so many users decided to use Excel instead of other 

tools in data analysis.  

 

To retrieve valuable information from Excel data you can use, 

1. Auto subtotal 

2. Filter 

3. Sorting 

4. Table features 

5. Functions 
 

Besides all these, sometimes we prefer to find the information from 

different orientation of data. In order to do this, we can use Pivot Table. 

 

Pivot tables are one of Excel's most powerful features. A pivot table allows 

you to extract the significance from a large, detailed data set. 

 

EX9.1: Create PivotTable 

In this exercise, you will learn how to create PivotTable to analysis data from 

Employee table. 

1. Select TblEmployee from Excel Name Box. 

 
 

2. This will bring you to the TblEmployee table. While the table is 

selected, select Insert tab. Select PivotTable button. 

 
 

3. In the Create PivotTable dialog box, just press OK button. 
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4. A new PivotTable is created in new worksheet. 
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 EX9.2: View fields and data 

In this exercise, you will learn how to view field and data from a PivotTable. 

1. From the previously created PivotTable 
a. Drag the Department field to Report Filter. 

b. Drag the Gender field to Row Labels. 

c. Drag the Gender field again to Value. 

 
What kind of information the PivotTable showing now? 

 

2. Try to select Filter button under Report Filter. Just select IT then 

press OK. 

 
What kind of information the PivotTable showing now? 

3. Now Drag the Department field from Report Filter to Column 
Labels. Observe the result produced. 
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4. Try to play around with the PivotTable to find out the following 

information: 

a. Number of employees for each department 

b. Average employee Monthly Salary for each department 

c. Average Salary for different gender 

 

Give your PivotTable a name 

When PivotTable is created, Excel will assign a default name to it. If you 

want to rename it, there are many possible ways. One of the simplest ways 

is 

1. Select Options tab 

 

2. Change the name from the PivotTable Name field 
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Change field settings 

When fields are dragged to the areas, Excel will provide default setting for 

the fields. Sometime the customization of the field is needed.  

 

To change the field setting, just click on the dropdown arrow for each 

field: 

 
 

You should be able to find the Field Settings… 

 
 

Styles 

To change the PivotTable style, 

1. Select Design tab 

 
 

2. You can select any desire style 
 

3. More style will be listed if you select the dropdown button. 
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 EX9.3: Filter a field 

In this exercise, you will learn how to filter a field to hide unwanted candidates. 

1. From the previous PivotTable, select Column Labels dropdown 
button. 

 
 

2. Just select IT, Operation, and R&D. Press OK. 

 
 

3. Observe the result. 
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Creating PivotChart Reports 

A pivot chart is the visual representation of a pivot table in Excel. Pivot 

charts and pivot tables are connected with each other. 

 EX9.4: Create PivotChart 

In this exercise, you will learn how to create PivotChart. 

1. Select TblEmployee from Excel Name Box. 

 
 

2. This will bring you to the TblEmployee table. While the table is 

selected, select Insert tab. Select PivotTable dropdown button, 

then select PivotChart. 

 
 

3. In the Create PivotTable with PivotChart dialog box, just press 

OK. 
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4. Try to drag around with the PivotTable to find out the following 

information: 

a. Drag the Department field to Row Labels. 

b. Drag the Gender field to Report Filter. 

c. Drag the Gender field again to Value. 

 

5. Try to change other setting to make the final result looks like the 
following: 
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Module 10 – What-If Analysis  

What is What-If Analysis? 

What-if analysis is the process of changing the values in cells to see how those 

changes will affect the outcome of formulas on the worksheet. Three kinds of 

what-if analysis tools come with Excel: scenarios, data tables, and Goal Seek. 

Scenarios and data tables take sets of input values and determine possible results. 

Solving single Variable Problem using Goal Seek 

The goal seek function, part of Excel's what-if analysis tool set, allows the user to 

use the desired result of a formula to find the possible input value necessary to 

achieve that result.  

Exercise 10.1: Loan 

 

Place selection at cell D6. 

  

Select Scenario Manager from Data Ribbon Tab 
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Press Add 

 

Name the Scenario as “Base”.  

Select Changing cells. 

Press OK. 
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Press OK. 

 

Press Close. 

Place selection at cell D6 again. 

 

Select Goal Seek from Data Ribbon Tab 
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Press OK. 

 

Press OK. Then select Scenario Manager from Data Ribbon Tab 

 

Press Add. 



 

120  

 

Name the Scenario as “Earliest Settlement”, then press OK. 

 

In the Scenario Values Dialog Box, press OK. 
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Select Scenario “Base”, then press Show. 

 

Beware that the model reset back to Base scenario. 

Press Close. 

While the selection still with cell D6, select Goal Seek from Data Ribbon Tab 

 

Prepare the value as below: 

 

Press OK. 
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Press OK to close the Goal Seek Status Dialog Box. 

Press OK. Then select Scenario Manager from Data Ribbon Tab 

 

Press Add to add new Scenario. 

 

Name the new Scenario as “Max Loan”. Press OK 

In the Scenario Values Dialog Box, press OK. 
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Now, Press Summary button. 

 

Press OK under Scenario Summary Dialog Box. 

 

A Scenario Summary Sheet is generated. 

Back to Goal Seek worksheet. 

Select cell D6 again. 
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Press OK. Then select Scenario Manager again from Data Ribbon Tab 

 

Select Scenario Base, then press Show. 

 

Beware that the model reset back to Base scenario. 

Press Close. 

While the selection still with cell D6, select Goal Seek from Data Ribbon Tab 

 

Prepare the value as below: 
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Press OK. 

Explain what you get. 

Press OK to end the exercise. 
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What is Data Table? 

A data table is a range of cells that shows how changing one or two variables in 

your formulas affects the results of those formulas. 

Exercise 10.2: Solving Single Variable Problem 
 

Prepare new worksheet with name “Data Table (1 Var)” 

 

Name the cells as below: 
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Prepare the following formula as below: 

 

Complete the worksheet as below: 

 

Select Home ribbon Tab 
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Highlight range F5:H19 and select New Rule under Conditional Formatting. 

 

Select Rule Type as Format only cells that contain 
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Prepare the Edit the Rule Description as below: 

 

Click Format. 

 

Set the font to Bold and Red. 
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Set the fill color to Pink. Press OK. 

 

Press OK. 

Select Range E4:H19 



 

131  

 

Go to Data Ribbon Tab. 

 

Under What-If Analysis, select Data Table. 

In the Data Table Dialog Box, place the editing cursor to Column Input Cell 

field. 

Click on cell C3. 

Now, you should get the following: 
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Press OK. 

 

Explain the meaning of the outcome. 
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Exercise 10.3: Solving Two Variables Problem 
 

Copy worksheet “Data Table (1 Var)”. 

Rename the copy as “Data Table (2 Vars)” 

 

Switch to the new copy. 

Delete entire columns D:H 

Prepare the following: 

 

Select the similar conditional formatting for negative value as before in worksheet 

“Data Table (1 Var)” for Range F5:O24. 

Select range E4:O24 
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Go to Data Ribbon Tab. 

Under What-If Analysis, select Data Table. 

 

 

Prepare the following Data Table Dialog Box: 

 

Press OK. 

 

Explain the result. 
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What is Solver? 

In Excel, Solver is part of a suite of commands sometimes called what-if analysis 

tools. With Solver, you can find an optimal (maximum or minimum) value for a 

formula in one cell — called the objective cell — subject to constraints, or limits, 

on the values of other formula cells on a worksheet. 

Enable Solver 

Solver by default is not enabled. Before we can use it, we need to enable it. 

Go to backstage of Excel by click on the File at the top left of Ribbon. 

 

Select Option. 

 

Under Excel Options Dialog Box, Select Add-Ins. 

Then Click Go… 
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Under Add-Ins Dialog Box, Check the Solver Add-In. 

Press OK. 
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Select Data Ribbon Tab, you should be able to see the Solver button at the far 

right. 

 

Solver is enabled now.  
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Set up Model 

Assuming that you are running a furniture factory. Your factory mainly produce 

tables. Currently you hired 3 skillful senior workers that work 10 hours per day 

and 10 less skillful workers that work 8 hours per day. 

Currently your factory has two types of table: 

1. Maple Table 

 
2. Mahogany Table 

 
 

Your factory has unlimited supply of maple, but limited supply of mahogany. 

Before we start the exercises. Let’s prepare our basic model. 

Create a new worksheet. 

Name it as “Solver” 
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Prepare the content as below: 

 

Name the cells as below: 

 

  



 

140  

Assign Formulas: 

 

So, the basic model is done. 

Exercise 10.4 

Copy worksheet “Solver”, and rename the copy as “Solver(Ex1)” 

 

Switch to worksheet Solver(Ex1) now. 

Select Data Ribbon Tab. 

 

At the far right, select Solver. 

 

In the Solver Variables Dialog Box, select cell TotalRevenue under Set 

Objective field, and select range D4:D5 under By Changing Variables Cells 

field as below: 

 



 

141  

 

Click Add button. 

In the Add Constraint Dialog Box, prepare the following: 

 

Press OK. 

You should get the following: 
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Beware that the constraint is applying names. In fact this is one of the very useful 

aspect of using name instead of address. 

Continue adding the rest of the constraints but pressing Add. 
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Eventually the constraint set should be as below: 
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Press  to let the solver start finding solution. 

 

Press OK to complete the solution. You should get the following result. But… 
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What’s wrong?? 

Run Solver Again. 

 

Select the above highlighted constraint. Press Change. 

 

Change the operator. 

Press OK. 
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Press Solve. 

 

Press OK under Solver Result dialog Box. 
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Discuss the new result with your classmate. 

What is the man-power utilization in this case? 
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Exercise 10.5 

In order to maximize the man-power utilization, your factory plan to produce 

another type of table called Plywood table which does not require very skillful 

workmanship. 

 

Let’s change the model a bit to find out the optimum result. 

Copy Worksheet “Solver” and rename the new copy as “Solver(Ex2)”. 

 

 

 

Name the new cells: 



 

149  

 

Assign new formula and change some formulas: 

 

Try to find out optimum solution. 
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Exercise 10.6 

After introduce too many types of tables, you just realized that your factory 

warehouse already reached its capacity constraint. You have to take into account 

this new constraint in your solution. 

Let’s do it. 

Copy Worksheet “Solver(Ex2)” and rename the new copy as “Solver(Ex3)”. 

 

Add new constraint to the model. 

 

Try to use solver to find the optimum result. 

Discuss your finding with your classmates.  
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Exercise 10.7 

After running the factory for few years, the senior skillful workers request to work 

only maximum 8 hours per day due to aging problem. 

You need to remodel your solution again. 

Copy Worksheet “Solver(Ex3)” and rename the new copy as “Solver(Ex4)”. 

 

Change the constraint values 

 

Try to use solver to find the optimum result. 

Discuss your finding with your classmates. 
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Module 11 – Data Visualization  

Creating Charts 

When presenting information, picture normally is better than thousands 

words. Charting allows use visualize our data/information graphically. 

 
 

11.1: Add Chart 

In this exercise, you will learn how to add column chart in to worksheet. 

1. Switch to Employee worksheet. Select columns Name and Age from 

table TblEmployee. 

 



 

153  

2. Select Insert tab. Column button. Under 2-D Column, select first 

chart (Clustered Column) type. 

 
 

3. New clustered column chart is created as below: 

 
 

4. While the chart is selected, select the More dropdown button under 

Design tab. 
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5. Select Style 28. 

 
 

6. Now the chart will look like below: 
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Changing the Chart Location and Size 

You can easily move and resize chart simply by using mouse. 

Chart also can be moved to other sheet. 

 

11.2: Move Chart 

In this exercise, you will learn how to move chart to new chart sheet. 

1. Right click the previously created chart, select Move Chart… 

 
 

2. In the Move Chart dialog box,type Employee-Age under New 

sheet field. Click OK. 
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3. Now the chart is moved to new chart sheet as below: 

 
 

 

Changing the Chart Type 

To change chart type, just right click on the chart then select Change 

Chart Type… 

 

  



 

157  

Modifying Chart Elements 

You can decide what type of elements can appear in the chart by using 

buttons under Layout tab. 

 

 
 

 

 

Formatting Chart Elements 

The appearance of the chart element can be change independently by select 

and right click, then change from the floating menu. 
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Adding and Removing Data Series 

Charts may have multiple data series. 

  

 
 

 

 

EX11.3: Create multiple Data Series chart 

In this exercise, you will learn how to create multiple data series chart. 

1. Switch to Employee worksheet. Select Columns (Inclusive headers) 

Name, Basic Salary and Monthly Salary. 

Hint: use control-drag to select disjointed range. 
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2. Select Insert tab, Column button under Charts group, click 

Clustered Column chart type. 

 

 

3. New multiple data series chart is created. 
 

EX11.4: Remove Data Series 

In this exercise, you will learn how to remove data series from chart. 

1. Right click on the previously created multiple data series column chart. 

Click Select Data… option. 
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2. In Select Data Source dialog box, select Monthly Salary under 

Legend Entries (Series) then click Remove button. Click OK to 

end the dialog box  

 
 

3. Now the chart change to 
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Printing Charts 

To print chart, common practice is 

1. First of all, move the chart to separate chart sheet.  

2. Make sure that the chart sheet is active sheet 

3. Click Office button, select Print menu item, the Print option 

 

4. In the Print dialog box, select the printer in used and configure 

printer properties. Ensure that Active sheet(s) is selected then click 

OK to start printing. 
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Creating and Using a Chart Template 

After you created a chart with the format or style that you like, you can 

then save it as chart template. 

 

In the future you can apply the chart template to other chart with the same 

type. With this you are not only save time, consistency of look and feel for 

the charts with the same type are preserved. 

 

 
 

 

 


